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When you complete this manual, you will have experienced 
firsthand an introduction to the capabilities of SolidWorks® 
Simulation products, including: 

SolidWorks® Simulation
SolidWorks® Simulation Professional
SolidWorks® Flow Simulation
SolidWorks® Motion
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Introduction
The SolidWorks® Simulation Hands-on Test Drive provides you with an 
understanding of the capabilities and benefits of using SolidWorks® Simulation 
analysis software to perform powerful analysis from your desktop. 
Only SolidWorks Simulation validation tools provide seamless integration with 
SolidWorks® 3D CAD software, with the benefit of the easy-to-use Windows® 
user interface.
Learn how you can use SolidWorks Simulations to perform stress analysis on your 
design; SolidWorks® Simulation Professional to perform stress, thermal, 
optimization, and fatigue analysis; SolidWorks® Motion to perform motion 
simulations; and SolidWorks® Flow Simulation to perform fluid-flow analysis on 
your designs.
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The SeaBotix LBV150 
During this hands-on session, you will analyze some of the parts and assemblies 
that are components of the SeaBotix LBV150 assembly shown below.
SeaBotix, Inc. designed, manufactured, and introduced the first lightweight, low-
cost, fully production submersible, remotely operated vehicle, the Little Benthic 
Vehicle. Bringing this breakthrough product to a wider market required modern 
3D design and analysis tools, so product developers could shorten design cycles, 
validate cutting-edge technologies, and employ organic shapes and surfaces.
The company selected SolidWorks mechanical design software for the Little 
Benthic Vehicle project because of its ease of use, ability to model organic shapes 
and surfaces, SolidWorks® eDrawings® communication capabilities, and seamless 
integration with SolidWorks® Simulation analysis software. 
The SeaBotix assembly can be remotely operated for use at depths of up to 1,500 
meters. Weighing less than 25 pounds, the SeaBotix assembly represents a 
breakthrough in tethered submersible design.

You will have a chance to experience firsthand the ease of using SolidWorks® 
Simulation analysis software on the following items: 

SeaBotix LBV150 assembly
Housing assembly
MiniGrab assembly
EndCap part
3 Finger Jaw part

 
 

SeaBotix
LBV150

ClampMiniGrab
Assembly

Bent Bar

View Port
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Today, you will use the SolidWorks Simulation family of products:

SolidWorks® Simulation - The static analysis application that determines the 
stresses on the Housing assembly and the EndCap part.
SolidWorks® Simulation Professional - The static, thermal, drop test, and 
optimization analysis application that validate the design of the Housing 
assembly, EndCap part, and the 3 Finger Jaw part.
SolidWorks® Motion - The ridge body motion analysis application that 
simulates the mechanical operation of the motorized MiniGrab assembly and 
the physical forces it generates.
SolidWorks® Flow Simulation - The fluid flow analysis application that 
provides insight into the SeaBotix LBV150 assembly related to fluid flow and 
forces on the immersed model.
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User Interface
The first thing that you notice about the SolidWorks® user interface is that it looks 
like Microsoft® Windows®. That is because it is Windows!
The SolidWorks 2013 (UI) is designed to make maximum use of the Graphics 
area space. Displayed toolbars and commands are kept to a minimum. 
Communicate with SolidWorks through the drop-down menus, Context document 
sensitive toolbars, Consolidated toolbars, or the CommandManager tabs.

Menu Bar Toolbar
The Menu Bar toolbar contains a set of the most frequently used tool buttons. The 

available tools are: New  - Creates a new document, Open  - Opens an 

existing document, Save  - Saves an active document, Print  - Prints an 

active document, Undo  - Reverses the last action, Select  - Selects sketch 

entities, faces, edges and so on, Rebuild  - Rebuilds the active part, assembly, 

or drawing, File Properties  - Shows the summary information of the active 

document, Options  - Changes system options, document properties, and Add-
Ins for SolidWorks.

Menu Bar Menu
Click the SolidWorks name in the Menu Bar toolbar to display the default Menu 
Bar menu. SolidWorks provides a context-sensitive menu structure. The menu 
tittles remain the same for all three types of documents; part, assembly, and 
drawing but the menu items change depending on which type of document is 
active. The display of the menu is also dependent on the work flow customization 
that you have select. The default menu items for an active document are: File, 
Edit, View, Insert, Tools, Window, Help, and Pin.

Note: The Pin  option displays both the Menu Bar toolbar and the Menu Bar menu.
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Drop-down menu / Context Toolbar
Communicate with SolidWorks 
either thought the Drop-down 
menu or the Pop-up Context 
toolbar. The Drop-down menu 
from the Menu Bar toolbar or the 
Menu Bar menu provides access 
to various commands. 
When you select, (click or right-
click) items in the Graphics area 
or FeatureManager, Context 
toolbars appear and provide 
access to frequently performed 
actions for that context. 

Keyboard Shortcuts

Some menu items indicate a keyboard shortcut like this: . 
SolidWorks conforms to standard Windows conventions for shortcuts such as 
Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+X for Cut; Ctrl+C for Copy; 
and so on. In addition, you can customize SolidWorks by creating your own 
shortcuts. 

FeatureManager Design Tree

The FeatureManager® design tree is a unique part of the 
SolidWorks software that employs patented SolidWorks 
technology to visually display all of the features in a 
part, assembly, or drawing. 
As features are created, they are added to the 
FeatureManager. As a result, the FeatureManager 
represents the chronological sequence of modeling 
operations. The FeatureManager also allows access to 
editing the features and objects that it contains. The Part 
FeatureManager consist of four default tabs: 

FeatureManager , PropertyManager , 

ConfigurationManager , DimXpertManager  

and DisplayManager .
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SolidWorks Simulation CommandManager Tab
The SolidWorks Simulation CommandManager enables you to quickly create a 
Simulation Study. Click the SolidWorks Simulation tab in the CommandManager 
to create a new study. Studies are organized in tabs and are displayed in the 
bottom section of the Graphics area.

Note: Create a New Study using 

the New Study  tool or 
right-click on the Motion 
Study tab, click Create 
New Simulation Study. 

Note: To activate SolidWorks 

Simulation, click the Options  drop-down arrow 
from the Menu bar toolbar. Click Add-Ins. The Add-
Ins dialog box is displayed. Check the SolidWorks 
Simulation box. Click OK from the Add-Ins dialog 
box. The Simulation tab is displayed in the 
CommandManager.

Mouse Buttons
The left, middle, and right mouse buttons have specific uses in SolidWorks.

Left - Selects objects such as geometry, menu buttons, and objects in the 
FeatureManager design tree.
Middle - Holding the middle mouse button as you drag the mouse rotates the 
view. Holding the Shift key down while you use the middle mouse button 
zooms the view. Using the Ctrl key scrolls or pans the view.
Right - Activates context-sensitive pop-up menus. The contents of the menu 
differ depending on what object the cursor is over. These right-mouse button 
menus give you shortcuts to frequently used commands.
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System Feedback
System feedback is provided by a symbol attached 
to the cursor arrow indicating what you are 
selecting or what the system is expecting you to 
select. As the cursor floats across the model, 
feedback comes in the form of symbols riding 
next to the cursor arrow.

Getting SolidWorks Help
SolidWorks has a comprehensive Home help Page 
function that is design to assist the new and 
experience user. It provides information on What’s 
New, SolidWorks Glossary, New Release notes, and 
more. 

Click Help, SolidWorks Help  from the Menu 
bar menu to view the comprehensive SolidWorks 
online Home help Page.

Note: Check Use SolidWorks Web Help for internet 
access.
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Getting SolidWorks 
Simulation Help

Click Study Advisor, 

Study Advisor  
from the Simulation tab 
in the 
CommandManager with 
an active study to obtain the Simulation Advisor. 
The Simulation Advisor is a tool to help the user to determine how to create the 
proper study. It is broken into the following categories: Study, Bodies and 
Material, Interactions, Mesh and Run, and Results.
The Simulation Advisor walks you through by asking basic questions to lead to 
the correct action. By default, when you click on a tool in the Simulation 
CommandManager, it launches the relevant advisor. Deactivate the Simulation 
Advisor in the Simulation Options section.

Note: The Simulation 

Advisor  tab is 
displayed in the Task 
Pane. 
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SolidWorks Tutorials and 
SolidWorks Simulation 
Tutorials

The SolidWorks Tutorials 
provide step-by-step 
lessons with sample files 
covering SolidWorks 
terminology, concepts, 
functions, features, and 
many Add-Ins. Work or 
view the lesson tutorials to 
learn and strengthen your 
skills. 
Click Help, SolidWorks 
Tutorials or click 
SolidWorks Simulation, 
Tutorials from the Menu 
Bar menu. View the results. 
The Tutorials are displayed 
by category.

Note: You can also access the 
SolidWorks Tutorials, click 
the SolidWorks Resources 

 tab from the Task Pane 
and click Tutorials. View 
the available tutorials. 

Note: Use the What’s New 
Examples to view whats 
new in SolidWorks 2013.
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SolidWorks Simulation

SolidWorks® Simulation is a design analysis application fully integrated with 
SolidWorks. It provides a one-screen solution for stress analysis and also enables 
you to solve large problems quickly using your personal computer. In this section 
of SolidWorks Simulation, you will address the following:

SolidWorks Simulation User Interface
The integration between SolidWorks Simulation and SolidWorks
Creating Design Studies
Understanding the Analysis Steps
Assigning Materials
Applying Fixtures and Loads
Meshing the Model
Running the Analysis
Viewing the Results

Time: 55 - 60 minutes
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SolidWorks and SolidWorks Simulation
SolidWorks Simulation allows you to test a design and run 
multiple analysis iterations without ever leaving SolidWorks. 
SolidWorks Simulation utilizes the SolidWorks FeatureManager 

 tab, PropertyManager  tab, ConfigurationManager  

tab, and the DisplayManager  tab, the CommandManager, 
Motion Study tabs, Material Library, etc. and many of the same mouse and 
keyboard commands. 
Anyone who can design a model in SolidWorks can analyze it without having to 
learn a new user interface. SolidWorks Simulation utilizes the power of 
SolidWorks configurations to test multiple designs. Plus, since SolidWorks 
Simulation uses native SolidWorks geometry, design changes made in one 
application are automatically updated in the other.
Regardless of the industry application, from aerospace to medical, SolidWorks 
Simulation provides significant product quality benefits, enabling engineers and 
designers to go beyond hand calculations and verify proof of concept for their 
designs.
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Analyze the Housing
For your first analysis, explore the design 
validation of the Housing components in the 
SeaBotix LBV150 assembly using 
SolidWorks Simulation.
The Housing was simplified for today’s class 
due to limited time. The Housing consists of 
two EndCaps and a View Port. The support 
tube, camera, and other components have 
been removed. 
Your design goal in this section is to obtain a 
Factor of Safety (FOS) greater than one. You 
will first perform a static analysis on the 
Housing assembly containing the EndCaps 
without structural ribs as illustrated. 
You will then perform a second static 
analysis on the Housing assembly containing 
the EndCaps with the addition of structural 
ribs as illustrated in hopes that the addition 
of the structural ribs will obtain your design 
goal of an FOS greater than one. 
You will then compare the two studies side-
by-side for a final design comparison.

View Port

EndCap 
with Ribs

EndCap
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Starting a SolidWorks Session
1 Start a SolidWorks Session.

Click the Start menu. 
Click All Programs, SolidWorks 2013, SolidWorks 2013. 

Note: You can quickly start a SolidWorks 2013 session by double-clicking the 
left mouse button on the desktop shortcut, if there is a shortcut icon on 
the system desktop. 

2 Open the SeaBotix LBV150 
Assembly.

Click Open  from the 
Menu bar toolbar. 
Double-click LBV_ASSY 
from the 
SeaBotix\SolidWorks 
Simulation folder. A 
simplified sub-assembly is 
displayed in the Graphics 
area. View the 
FeatureManager.

Note: The FeatureManager design tree 
on the left side of the SolidWorks 
window provides an outline view 
of the active part, assembly, or 
drawing. This makes it easy to 
see how the model or assembly 
was constructed or to examine the 
various sheets and views in a 
drawing.



SolidWorks Simulation SolidWorks Simulation

Analyze the Housing 15

3 Select the Simulation_Original_Design 
Configuration.

Click the ConfigurationManager  tab. The 
various configurations are displayed.
Double-click the Simulation_Original_Design 
configuration. The Housing assembly (No Ribs) is 
displayed in the Graphics area. 

4 Activate SolidWorks Simulation.

Click the Options  drop-down arrow 
as illustrated from the Menu bar toolbar. 
Click Add-Ins. The Add-Ins dialog box 
is displayed.
Check the SolidWorks Simulation box. 
Click OK from the Add-Ins dialog box. 

Note: Displayed Add-Ins may vary per system 
setup.
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A Simulation tab is added to the CommandManager and a Simulation button is 
added to the Menu bar menu. 

5 Set Default Options in SolidWorks Simulation.
Click the Simulation button from the Menu bar 
menu. 
Click Options from the drop-down menu. The 
System Options - General dialog box is displayed.



SolidWorks Simulation SolidWorks Simulation

Analyze the Housing 17

Click the Defaults Options tab. View the 
Default Options - Unit dialog box.
Click the Units folder. 
Click the SI (MKS) Unit system box.
Select mm for Length/Displacement.
Select Kelvin for Temperature.
Select rad/sec for Angular velocity.
Select N/mm^2(MPa) for Pressure/Stress.

6 Set Results Folder.
Click the Results 
folder.
Click the Automatic 
box in the Default 
solver section.

7 Set Number Format.
Click the Color Chart 
folder.
Click Floating for Number format. View your options.
Click OK from the Default Options - Plot Color Chart dialog box.



SolidWorks Simulation SolidWorks Simulation

18 Create a Static Analysis Study

Create a Static Analysis Study
Create a Static study today. Static studies calculate 
displacements, reaction forces, strains, stresses, and 
factor of safety distribution. 
Factor of safety calculations are based on common 
failure criteria. 
The first default Study name is Study 1.
SolidWorks Simulation offers six different results 
options. They are:

Stress
Displacement
Strain
Deformation
Factory of Safety
Design Insight

Static studies can help you avoid failure due to high 
stresses. A factor of safety less than one indicates likely 
material failure. Large factors of safety in a continuous 
region indicate that you can probably remove some 
material from this region.

Note: The 2D Simplification option creates a 2D simplification 
study to simplify certain 3D models by simulating them 
in 2D and saving analysis time. Available analysis types 
include plane stress, plane strain, extruded and 
axisymmetric.
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Creating a Static Analysis 
Study

1 Create a Static 
Analysis Study.

Click Simulation 
tab in the 
CommandManager. 
Click the Study Advisor drop-down arrow as 
illustrated. 
Click New Study . The Study PropertyManager is 
displayed. Study 1 is the default name for the first 
study. Accept the default Study name. View the 
various available Study types.
Click the Static  button for Type.

2 Display the Study.

Click OK  from the Study PropertyManager. 
Study 1 (-Simulation_Original_Design-) is 
displayed. View the default folders.

3 Return to the FeatureManager.

Click the FeatureManager  tab.

Note: A green check mark  on a Study folder indicates 
that material is assigned. 

Note: If needed, return to the FeatureManager.
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Assigning Materials in SolidWorks 
Simulation

You can apply a material to a part, and create or 
edit a material with the SolidWorks Simulation 
Material dialog box.
The Properties tab in the Material dialog box 
allows you to define a material source, material 
model, and material properties. You can define 
constant or temperature-dependent properties.
Defining materials in SolidWorks Simulation 
does not update the material assigned to the 
model in SolidWorks.
Define and apply material to the two EndCaps in the Housing assembly in the next 
section. 
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Selecting parts and Applying Material in 
SolidWorks Simulation

1 Select the two EndCaps.
Expand the Parts folder.
Click the first CH EndCap part. 
Hold the Ctrl key down.
Click the second CH EndCap part.
Release the Ctrl key.
Click Apply Material  from the 
Simulation tab in the CommandManager. 
The Material dialog box is displayed.

2 Assign Material.
Expand the Steel folder. 
Click AISI 1020. View the available 
material properties and information.
Click Apply.
Click Close from the Material dialog 
box. View the results in the Study tree.

Note: A green check mark  on the Parts folder 
indicates that material is assigned to the 
parts. 
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Applying Fixtures
A component that is not fixed will 
travel indefinitely in the direction 
of the applied load as a rigid body. 
Fixtures and loads define the 
environment of the model. 
A rigid body contains six degrees 
of freedom, three rotational and 
three translational. You apply 
restraints to remove degrees of 
freedom. 
Each load or fixture condition is 
represented by an icon in the 
Study. 
In this section, address an On 
cylindrical face fixture. 
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Applying a Fixture
1 Apply a Fixture.

Click the Fixtures Advisor drop-
down arrow from the Simulation tab 
in the CommandManager. 
Click Fixed Geometry. The Fixture 
PropertyManager is displayed. The 
Fixed Geometry option is selected by 
default. Fix the model to simulate 
how the two EndCaps are mounted to 
the Housing.

2 Select the Faces to be Fixed.
Click the cylindrical face of 
the right EndCap as 
illustrated. Face<1> is 
displayed in the Standard 
(Fixed Geometry) box. 
Click the cylindrical face of 
the left EndCap as 
illustrated. 

3 Set Fixture Type.
Expand the Advanced dialog box.
Click the On Cylindrical Faces box. The 
Translations dialog box is displayed.
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4 Select Units and Displacement 
Components.

Select mm from the Unit 
drop-down menu.
Click the Circumferential 

 box. 

Click the Axial  box. 
View the results in the 
Graphics area.

5 Apply the Fixture.

Click OK  from the Fixture 

PropertyManager. An icon  named On 
Cylindrical Faces-1 is displayed in the 
Fixtures folder.

Note: Press the f key to fit the model to the Graphics 
area. 
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Applying Loads
Loads are forces and pressures applied to 
faces, edges, and vertices of the model. 
In SolidWorks Simulation you can apply 
uniform and variable force and pressure, 
torque, bearing loads, and body forces 
such as gravity and centrifugal force. 

You will apply a Pressure load to the 
Housing. The Pressure load will 
simulate approximately 3,400 feet of 
seawater. 

Note: You will use English (IPS) units in this 
section. Each 33.3 ft. of seawater is 
approximately equivalent to 1 ATM or 
14.7 PSI.

Apply the Normal to selected face 
option for Pressure Type. 
Select all exposed faces of the 
Housing to apply a pressure load to 
simulate the seawater depth 
pressure. 
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Applying a Pressure Load
1 Apply a Pressure Load.

Click the External Loads 
drop-down arrow from the 
Simulation tab in the 
CommandManager. 

Click Pressure . The 
Pressure 
PropertyManager is 
displayed. The Type tab is 
selected by default.
Click the Normal to 
selected face box.

2 Select the Faces to Apply the 
Load.

Rotate the model with the 
middle mouse button as 
illustrated.
Click the front EndCap as 
illustrated. Face<1> is displayed 
in the Faces for Pressure box.

Zoom in on the front 
EndCap as illustrated.
Click the other three 
faces of the front 
EndCap. Face<2>, 
Face<3>, and Face<4> 
are displayed in the Faces 
for Pressure box. 

Note: If you select an incorrect face, 
right-click inside the Faces for 
Pressure box and click Delete 
if deleting a single face or 
click Clear Selections if you 
want to clear all entries. 

Note: Face ID’s in list may vary.
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3 Select the View Port Face.
Press the f key to fit the model to 
the Graphics area.
Rotate the model with the middle 
mouse button as illustrated.
Click the View Port face. Face<5> 
is displayed in the Faces for 
Pressure box. Note the icon 
feedback symbol for a face and 
displayed feature information.

Note: Do not select an inside face. 

4 Select the Faces to 
Apply the Load.

Zoom in on the 
back EndCap 
face as illustrated.
Rotate the model 
with the middle 
mouse button to 
select the other 
four faces of the 
back EndCap.
Click the four 
faces of the back 
EndCap as 
illustrated. Nine 
faces are 
displayed in the 
Faces for 
Pressure box.
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5 Set the Pressure Value.
Select psi from the Units drop-down menu. 
Enter 1500 in the Pressure Value box. 

6 Apply the Pressure.

Click OK  from the Pressure 
PropertyManager. SolidWorks Simulation applies 
1500 PSI pressure and creates an icon  named 
Pressure-1 in the External Loads folder as 
illustrated.

7 Fit the model to the Graphics area.
Press the f key. View the model in the Graphics 
area.

Note: If you change units after typing a value, SolidWorks 
Simulation converts the value to the new units.
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Creating a Mesh and Running the Analysis
Creating a Mesh is a very crucial step in design analysis. Meshing is basically 
splitting the geometry into small, simply shaped pieces called finite elements. The 
automatic mesher in SolidWorks Simulation generates a mesh based on a global 
element size, tolerance, and local mesh control specifications. Mesh control lets 
you specify different sizes of elements for components, faces, edges, and vertices.
SolidWorks Simulation estimates a global element size for the model taking into 
consideration its volume, surface area, and other geometric details. The size of the 
generated mesh (number of nodes and elements) depends on the geometry and 
dimensions of the model, element size, mesh tolerance, mesh control, and contact 
specifications.
Meshing generates 3D tetrahedral solid elements, and 2D triangular shell 
elements or 1D beam elements. After the mesh is created, you can run the 
analysis. SolidWorks Simulation solves a series of equations based on known 
material properties, restraints, and loads. The Static solutions provide information 
on displacement, stress, and strain.

Before Meshing After Meshing
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Creating a Compatible Mesh
1 Create a Compatible Mesh.

Expand the Component Contact folder from 
the Study tree.
Right-click Global Contact (-Bonded-).
Click Edit Definition. The Component Contact 
PropertyManager is displayed. View your 
options.
Click Compatible mesh from the Options box. 
Accept the default settings.
Click OK  from the Component Contact 
PropertyManager. In the next section, start the 
Meshing process. 

Note: You can also right-click Study 1 
and click Properties to set mesh 
compatibility. 
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Creating a Mesh
1 Create a Mesh. 

Click the Run drop-down arrow from the 
Simulation tab in the CommandManager. 
Click Create Mesh . The Mesh 
PropertyManager is displayed suggesting 
Global Size and Tolerance values. 

2 Review the Meshing Options.
Expand the Mesh Parameters box. View the 
available options. 
Click the Standard mesh box.
Expand the Advanced box. View the available 
advanced options for additional control. 
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3 Start the Mesh Process.

Click OK  from the Mesh 
PropertyManager. Meshing starts and the 
Mesh Progress window appears. After 
meshing is completed, SolidWorks 
Simulation displays the meshed model. A 
green check mark  is applied next to 
the Mesh folder in the Study.

Note: Right-click Mesh. Click Hide 
Mesh to toggle the visibility of the 
mesh.

Note: Right-click Fixtures. Click Hide 
All/Show All to toggle the visibility 
of the loads and fixtures.

4 Run the Analysis. 

Click Run  from the Simulation tab in 
the CommandManager. Three default plots 
are created.
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Viewing the Results
After a successful run of a Static analysis, SolidWorks 
Simulation creates three default plots: Stress, 
Displacement, and Strain.
The results are utilized with your design criteria to 
answer the following questions:

Will the model fail?
How will the model deform?
Can you reduce material or change material without 
affecting performance?

Note: Results may vary depending on mesh type, and system 
setup. 
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View the Results
1 Hide all symbols.

Click the drop-down menu from the 
Hide/ Show items  tool in the 
Heads-up toolbar as illustrated.
Click the View Simulation Symbol  
icon to hide all symbols.

2 View the von Mises Stresses.
Double-click Stress1 (-von Mises-). 
The Stress Plot PropertyManager is 
displayed. Plot units if needed can be 
modified from the PropertyManager.
Click OK  from the Stress Plot 
PropertyManager.

Note: The von Mises stress indicates the internal forces in a body when subjected to 
external loads for ductile materials. Most engineering materials are ductile.
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Note: To view the stress plot in a different unit system, right-
click the active plot icon. Click Edit Definition. Set 
units. Click OK from the Stress Plot PropertyManager. 

3 Display a Section View using the Top Plane.

Click the SolidWorks FeatureManager  tab. 
Click Top to select Top Plane as illustrated.
Click the Plot Tools drop-down arrow from the 
Simulation tab in the CommandManager.
Click the Section Clipping  tool as illustrated. 
The Section PropertyManager is displayed. Top is 
displayed in the Reference entity box.
Check the Show section plane box.
Un-check the Show contour on the uncut portion 
of the model box. View the default settings.
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Click OK  from the 
Section PropertyManager. 
Rotate the model as 
illustrated with the middle 
mouse button to view the 
results.

Note: Deformation is magnified for 
improved visibility. The 
deformation can be displayed at 
any scale.

Note: Use the Zoom to Area  tool 
located in the Heads-up View 
toolbar to Zoom in on a section 
of the model.

4 Display an Isometric view.

Click Isometric view  from the Heads-up 
View toolbar.

5 Probe the Model. 
Zoom in on the front EndCap.
Click the Plot Tools drop-
down arrow from the 
Simulation tab in the 
CommandManager.
Click Probe . The Probe 
Result PropertyManager is 
displayed.



SolidWorks Simulation SolidWorks Simulation

Viewing the Results 37

Click five points from front to back as illustrated.

Click the Plot  button from the Report Options 
box. View the results.

Note: Results will vary 
depending on the selected 
location of the points.

6 Review the Plot.
Review the plot. 
This is an excellent 
way to examine the 
variation in stress 
across the 
geometry of your 
part.

7 Close the Probe 
Results dialog box.

Close the Probe 
Results dialog box.

8 Close the Probe 
Result 
PropertyManager.

Click OK  from 
the Probe Result 
PropertyManager.
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9 Deactivate the Section Plot.
Click the Plot Tools drop-
down arrow from the 
Simulation tab in the 
CommandManager.
Click the Section Clipping 

 tool. The Section 
PropertyManager is 
displayed.
Click the Clipping on/off 

 button from the Options 
box as illustrated.
Click OK  from the 
Section PropertyManager.

10 Fit the model to the Graphics 
area.

Press the f key. View the 
results in the Graphics area.

11 View the Displacement 
Plot.

Double-click 
Displacement1 (-Res 
disp-) in the Results 
folder. View the plot.
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12 Animate the Displacement Plot.
Click the Plot Tools drop-down arrow from the 
Simulation tab in the CommandManager.
Click Animate . The Animation 
PropertyManager is displayed. View the animation 
in the Graphics area.

13 Stop the Animation.

Click Stop .

14 Save the Animation.
Check the Save as AVI file box as illustrated. 
Click the Browse button. Accept the default 
location.
Click Save from the Save As dialog box.
Click OK  from the Animation 
PropertyManager.

15 Calculate the Factor of Safety. 
Right-click the Results 
folder.
Click the Define Factor Of 

Safety Plot  tool. The 
Factor of Safety 
PropertyManager is 
displayed.
Select the Selected bodies 
button.
Click the first CH End Cap 
component in the graphics 
area.
Select Max von Mises 
Stress from the drop-down 
menu as Criterion. Note 
your options for Criterion.
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Click Next  to continue to 
step 2. Accept the defaults.
Click Next  to continue to 
step 3.
Click the Areas below factor 
of safety box.
Click OK  from the Factor 
of Safety PropertyManager. 
View the model in the Graphics 
area. 
Rotate the model with the 
middle mouse button. The area 
in blue has a FOS above 1. The 
area in red has a FOS below 1.

Right-click Factor of Safety1 
as illustrated from the Results folder.
Click Chart Options. The Chart 
Options PropertyManager is displayed.
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Check the Show min annotation box. Accept the 
defaults settings. View the results in the Graphics 
area.
Click OK  from the Chart Options 
PropertyManager. View the results.
Rotate the model with the middle mouse button. 
View the area in red. The area in red has a FOS 
below 1. The area in blue has a FOS above 1.

Note: The minimum FOS is approximately 0.66. You did not 
meet the design goal, which is to obtain a FOS greater 
than one. In the next study, add structural ribs to the 
EndCap to obtain the design goal.



SolidWorks Simulation SolidWorks Simulation

42 Creating a SolidWorks eDrawings File

Creating a SolidWorks 
eDrawings File

You can save result plots 
in the SolidWorks 
eDrawings® format. The 
SolidWorks eDrawings 
application provides a 
facility for you to 
animate and view your 
analysis results. You can 
rotate and zoom 
SolidWorks eDrawings 
using the eDrawings 
viewer. The eDrawings 
files are self-viewing, 
small, and hence 
convenient to send via 
email.
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Creating a SolidWorks eDrawings file
1 Create a SolidWorks eDrawings file.

Double-click Stress1 (-von Mises-) from the Results 
folder.
Click the Plot Tools drop-down arrow from the 
Simulation tab in the CommandManager.
Click Save As . The Save As box is displayed.
Select eDrawings Files for Save as type. Accept the 
default name and location.

Click Save.

2 Publish a SolidWorks 
eDrawing.

Click File, Publish to eDrawings 

 from the Menu bar menu. The 
Save Configurations to eDrawings 
file dialog box is displayed.
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Accept the default settings. Click OK from 
the dialog box. If needed click Yes to the 
dialog box. View the eDrawing.
Click Play . View the eDrawing.

Click Stop . 
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3 View the Stress1 (-von Mises-) 
Plot.

Click File, Open from the 
Main menu in eDrawings.
Double-click the LBV-
ASSY-Study 1 in the saved 
study folder. View the 
eDrawing for the von Mises 
Plot.
Click Play . View the 
eDrawing.
Click Stop .
Close the eDrawing and 
return to SolidWorks 
Simulation. 
Click No. Do not save the 
eDrawing.
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Generating a Report
The Report utility 
generates an Internet-
ready or Microsoft® 
Word document 
convenient for review 
by colleagues and 
supervisors. The report describes all aspects of the analysis including material 
properties, applied restraints and loads, and the results. 
SolidWorks Simulation generates reports in HTML format and Microsoft Word 
format.

MS Word Format
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Generating a Static Study 
Report

1 Generate a Static Study 
Report.

Click Report  
from the Simulation 
tab in the 
CommandManager. If 
needed, click OK to 
the dialog box.
Enter Description: 
HOTD Report.
Check the Designer 
box.
Enter Name.
Check the Company 
box.
Enter Name.
Check the Show 
report on publish 
box. Accept the 
default settings.
Click the Apply 
button.
Click the Publish 
button.
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2 View the Result.
Microsoft Word 
opens and the report 
is displayed. 
Review the contents 
of the report. Note 
Result plots are 
included.

3 Close the Report.
Close the report by 
exiting Microsoft 
Word and return to 
SolidWorks 
Simulation. The 
Report folder is 
displayed.

Note: Reports can be fully 
customized to your 
requirements.
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Analysis 2 - Static Study 2
In Study 1, the reports showed critical areas where 
the factor of safety was less than one. 
As a designer, you must decide how you can 
increase the factor of safety.

Do you change the material?
Do you modify the existing model?
Should you re-evaluate the restraints and 
loads?

In this section you will:
Modify the EndCap in the Housing assembly. 
Add ribs to the EndCaps to increase the structural 
integrity of the Housing. (Due to limited time in 
class, you will simply Unsuppress the ribs from 
the SolidWorks EndCap FeatureManager.)
Copy information from Study 1 to Study 2. 
Mesh and Run the new analysis. 
View the results of Study 2.
Compare Stress and FOS Plots between Study 2 
and Study 1.



SolidWorks Simulation SolidWorks Simulation

50 Analysis 2 - Static Study 2

Creating Analysis 2 - Static Study 2
1 Create Study 2.

Right-click the Study 1 tab in the 
bottom section of the Graphic area 
as illustrated.
Click Duplicate. The Define Study 
Name dialog box is displayed.
Enter Study 2 for Study Name.
Click OK from the Define Study 
Name dialog box. Study 2 is 
displayed. 

Note: Study 2 is a copy of Study 1.

2 Modify the EndCap Part.
Click the Model tab at the bottom of the 
Graphics area.
Expand CH EndCap - 300m STBD-no tab-
revf.
Right-click CirPattern1.
Click Unsuppress  from the Context 
toolbar. The Housing with the ribbed 
EndCaps is displayed in the Graphics area. 
Both instances of this part are updated.
Rotate the model with the middle mouse 
button to view the unsuppressed ribs. 

3 Return to Study 2.
Click the Study 2 tab at the bottom of the 
Graphics area.
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4 Review Study 2.
Review Study 2. The material and Load/
Fixture information from Study 1 is copied to 
Study 2. Since the geometry changed, Mesh 
the model and Run the analysis again.

5 Mesh the Model.
Click the Run drop-down arrow 
from the Simulation tab in the 
CommandManager.

Click Create Mesh . 
Click OK to the message, 
“Remeshing will delete the 
results for study: Study 2.” The 
Mesh PropertyManager is 
displayed suggesting Global Size 
and Tolerance value.
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6 Start the Mesh Process.
Check the Mesh Parameters box. View your 
options.
Check the Run (solve) the analysis box.
Click OK  from the Mesh PropertyManager. 
Meshing starts and the Mesh Progress window 
appears. View the results in the Graphics area.

7 View the Results Folder.
Expand the Results folder. 
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8 View the von Mises Stresses Plot.
Double-click Stress1 (-von Mises-). The von 
Mises stress plot is displayed. View your 
options.
Click OK  from the Stress Plot 
PropertyManager. View the results in the 
Graphics area.

Note: Results may vary depending on mesh type, system 
setup and system options.
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9 View the Factor of Safety.
Double-click Factor of Safety1 (-Max 
von Mises Stress-). 
Rotate the model to view the blue surface. 
The blue area displays a FOS above 1.

Note: The minimum FOS is now 1.12.

10 Compare Study 2 to Study 1.

Click Isometric view  from the 
Heads-up View toolbar.
Click (f) View Port in the 
FeatureManager.
Hold the Ctrl key down.
Click the second CH End Cap - 300mm 
component. Both components are 
selected.
Release the Ctrl key.
Right-click Hide components  from 
the Context toolbar. 
Double-click Factor of Safety1 (-Max 
von Mises Stress-). 
Click OK  from the Factor of Safety 
PropertyManager. The two components 
are hidden in the Graphics area. View the 
single CH End Cap.
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Rotate the model and view the results.

Click Compare Results  from the 
Simulation tab in the CommandManager. The 
Compare Results PropertyManager is displayed. 
Both Study 1 and Study 2 are checked.

Click the Manually select results to view box.
Un-check the Displacement1 and Strain1 box 
under Study 1.
Check the Stress1 and Factor of Safety1 box 
under Study 1.
Check the Stress1 and Factor of Safety1 box 
under Study 2.
Click OK  from the Compare Results 
PropertyManager. View the Graphics area. The 
two Studies are displayed. 
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Click the Exit Compare button 
in the Compare Results dialog 
box. 
Click the Study 2 tab if 
needed. Study 2 is displayed in 
the Graphics area.
Double-click Stress1 (-
vonMises-) from the Results 
folder. View the Graphics area.
Click the Model tab at the 
bottom of the Graphics area to 
return to SolidWorks and to 
displayed the Assembly 
FeatureManager.
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Click (f) View Port in the 
FeatureManager.
Hold the Ctrl key down.
Click the second CH End Cap 
- 300mm component. Both 
components are selected.
Release the Ctrl key.
Right-click Show 

components  from the 
Context toolbar. The 
components are displayed in 
the Graphics area. 

11 Return to Study 1.
Click the Study 1 tab at the 
bottom of the Graphics area. 
Study 1 is displayed.
Double-click Stress1 (-vonMises-) from the 
Results folder. View the Graphics area.
Click OK  from the Stress Plot 
PropertyManager.
Click Compare Results  from the 
Simulation tab in the CommandManager. The 
Compare Results PropertyManager is 
displayed. 
Click the Manually select results to view 
box.
Un-check the Displacement1 and Strain1 box 
under Study 1.
Check the Stress1 box and Factor of Safety1 
box under Study 2.
Click OK  from the Compare Results 
PropertyManager. View the Graphics area. The 
two Studies are displayed. 
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Click the Exit Compare button in the Compare Results dialog box. Study 1 is 
displayed in the Graphics area.

12 Save and Close the Model.

Click Save .
Click File, Close from the Menu bar menu. 

Note: Your design goal is complete. The structural ribs in the 
EndCap provided an FOS greater than one.
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SolidWorks Simulation Conclusion
During this short session on using SolidWorks Simulation, you have had a brief 
exposure to the main concepts of static analysis. Integrated within SolidWorks 3D 
mechanical design software, SolidWorks Simulation allows you to update all of 
your design changes automatically and to become immediately productive using 
familiar SolidWorks functions and commands.
Compare alternative designs easily and quickly. SolidWorks Simulation lets 
you study different design configurations created with SolidWorks software and 
choose the optimal design for final production.
Study the interaction between different assembly components. SolidWorks 
Simulation provides powerful tools for you to study and optimize assemblies.
Simulate real-world operating conditions. SolidWorks Simulation includes 
several types of loads and restraints as well as part-to-part contact to represent 
real-life situations. All loads and restraints are associative with the geometry and 
automatically update with changes in your design.
Automate analysis tasks. SolidWorks Simulation utilizes a number of 
automation tools to simplify the analysis process and help you to work more 
efficiently.
Interpret analysis results with powerful and intuitive visualization tools. 
Once you have completed your analysis, SolidWorks Simulation offers a variety 
of results visualization tools that allow you to gain valuable insight into the 
performance of your models.
Collaborate and share analysis results. SolidWorks Simulation makes it easy 
for you to collaborate and share analysis results effectively with everyone 
involved in the product development process.
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SolidWorks Simulation Professional

When you complete this chapter, you will have experienced the power and 
capabilities of SolidWorks® Simulation Professional, including:

The benefits of Thermal analysis, Drop Test, Optimization, and Fatigue 
analysis.
The ease of use of SolidWorks® Simulation Professional to explore design 
iterations using Trend Tracker.
The steps for performing upfront analysis on your designs.
The integration between SolidWorks® Simulation Professional and 
SolidWorks.
The results of cost savings by avoiding field failures and eliminating the 
prototype bottleneck.
The ability to document your analysis findings automatically.
The method to update your assembly based on the analysis results.

Time: 35 - 40 minutes
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SolidWorks Simulation Professional
In the first part of your analysis, you utilized SolidWorks Simulation to perform 
two static analyses on the Housing. Next, you will use applications available in 
SolidWorks Simulation Professional to continue your investigation. SolidWorks 
Simulation Professional combines all of the features of SolidWorks Simulation 
plus additional software analysis applications. SolidWorks Simulation 
Professional includes:

Static analysis of parts and assemblies
Drop Test simulation
Frequency and Buckling analysis
Fatigue analysis
Optimization performance
Pressure vessel analysis
Thermal analysis
Trend Tracker to document design iterations

In this second part of your analysis, you will perform the following studies:
Thermal analysis to determine the heat dissipation from the EndCap 
surrounded by seawater. 
Drop Test simulation of the Housing from a height of four feet.
Optimization to find the best combination of EndCap thickness and Rib 
thickness to minimize the mass.
Fatigue analysis on the 3 Finger Jaw.

 

EndCap EndCap with Ribs

Housing 3 Finger Jaw
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Trend Tracker Analysis
When you complete this chapter, you will have 
experienced the power and capabilities of the 
trend analysis feature inside SolidWorks 
Simulation Professional.

Trend analysis allows you to track the 
changes that were made to your designs in a 
systematic way.
It helps you to compare the various design 
changes and understand why and how your 
changes were better or worse than your 
previous designs.
It provides complete and automated 
documentation of the analysis changes 
throughout your design cycle.

You will start by performing a trend analysis on 
the housing components of the SeaBotix LBV150 
assembly. This is the same assembly that you 
analyzed before using the static analysis feature 
inside SolidWorks Simulation.

Time: 15 - 20 minutes
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1 Open the Housing_Assy 
Assembly.

Click Open  from the 
Menu bar toolbar.
Double-click the LBV_Assy 
from the 
SeaBotix\SolidWorks 
Simulation 
Professional\TrendTracker 
folder. The LBV_Assy is 
displayed.

Note: View the Trend_Study tab in the 
bottom section of the Graphics 
area if SolidWorks Simulation is 
active.

2 If required, activate SolidWorks 
Simulation.

Click the Options  drop-down 
arrow from the Menu bar toolbar. 
Click Add-Ins. The Add-Ins dialog box 
is displayed.
Check the SolidWorks Simulation box.
Click OK from the Add-Ins box.

Note: You don't have to activate SolidWorks 
Simulation if your SolidWorks Simulation is 
already added in.

Note: To display the Simulation Advisor 
CommandManager, check the Run 
Simulation Advisor box under 
Simulation System Options.
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3 VIew the Trend Study.
Click the Trend Study tab as 
illustrated. The Trend Study is 
displayed.

4 Perform an Analysis on the Study.

Click Run  from the Simulation tab in the 
CommandManager. The analysis runs and 
three default plots are created.

5 View the Von Mises Stress on the EndCap.
The plot is displayed in the Graphics area. 
Double-click Stress1 (-vonMises-). The 
Stress Plot PropertyManager is displayed. 
View your available options.
Click OK  from the Stress Plot 
PropertyManager.

6 Fit the model to the Graphics area.
Press the f key. 

Tip: To Zoom out, press the z key.

7 Hide all symbols.
Click the drop-down menu from the Hide/ Show 

items  tool in the Heads-up toolbar as illustrated.
Click the View Simulation Symbol  icon to hide 
all symbols.
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Click the Plot Tools drop-down arrow from the 
Simulation tab in the CommandManager.
Click List Selected . The Probe Results 
PropertyManager is displayed.

Note: The On selected entities box is selected by default.

Zoom in on the front hole of the EndCap as 
illustrated.

Click the edge of the front 
hole of the EndCap. Note: The 
icon feedback symbol of an 
edge. Edge<1> is displayed in 
the Results box.
Click the Update button. View 
the results.
Click OK  from the Probe 
Result PropertyManager.
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8 Fit the model to the Graphics area.
Press the f key. 

Note: Study Advisor recommends study 
types and outputs to expect. Study 
Advisor helps the user to define 
sensors and creates studies 
automatically.
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9 Invoke Trend Tracker.
Right-click Trend Study (-
Simulation_Origin_Design). 
Click Trend Tracker. The Tend Tracker folder is 
displayed.

10 Set a Baseline.
Right-click the Trend Tracker folder.
Click Set Baseline. 
Expand the Trend Tracker folder. View the created 
graph icons. 

Note: The current stress analysis will be the baseline to which 
future designs are compared to. 

Perform design changes to strengthen the End caps. View 
how the new designs changes compare with the initial 
(Baseline) design in terms of: stress, displacement, etc. using the Trend Tracker 
tool. 
See how Trend Tracker allows you to perform design changes without creating 
multiple studies or configurations.
In the next section, define a sensor. You define sensors to monitor result quantities 
at a set of locations, mass properties of components or bodies, interferences 
between components for assemblies, and dimensions.
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11 Add Sensors.
Click the Model tab at the bottom of the 
Graphics area.
Right-click the Sensors folder from the 
Assembly FeatureManager. 
Click Add Sensor. The Sensor 
PropertyManager is displayed.
Select Simulation Data for Sensor type 
from the drop-down menu.
Select N/mm^2(MPa) for Units.
Select Max over Selected Entities for 
Criterion.
Right-click Clear Selections in the selection 
box as illustrated.

Click the edge of the front hole of the 
EndCap as illustrated. Note: The icon 
feedback symbol of an edge. Edge<1> is 
displayed in the selection box.
Click OK  from the Sensor 
PropertyManager.
Expand the Sensor folder in the Assembly 
FeatureManager. View the folders. 

12 Return to Trend Study. 
Click the Trend Study tab at the bottom of 
the Graphics area.
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13 Add a second Tracked Data Graph.
Right-click the Trend Tracker (Baseline) 
folder.
Click Add Tracked Data Graph. The 
Tracked Data Graph PropertyManager is 
displayed.
Select Stress2 for Sensor Type from the 
drop-down menu as illustrated. View your 
options.
Click OK  from the Tracked Data Graph 
PropertyManager. The Stress2 folder is 
displayed.

14 Perform a Design Change. Modify 
the EndCap Part.

Click the Model tab at the 
bottom of the Graphics area. The 
Assembly FeatureManager is 
displayed.
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Expand the first CH End Cap - 300m 
STBD from the FeatureManager as 
illustrated.
Right-click CirPattern1.
Click Unsuppress  from the Context 
toolbar. The Housing with the ribbed End 
caps is displayed in the Graphics area. 

15 Return to the Trend Study.
Click the Trend Study tab as the bottom 
of the Graphics area.

16 Run an Analysis.

Click Run  from the Simulation tab in 
the CommandManager. Once the analysis 
is completed, the plots under the Trend 
Tracker folder are updated. 
View the Stress1 (-vonMises-) plot.
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17 Examine the total mass of the 
EndCap Part.

Double-click the Mass1 
folded as illustrated. The 
total mass increase from the 
first iteration to the second 
iteration due to the addition 
of the ribs. 

Note: The additional weight is 
expected to increase the FOS.

Close the graph.

18 Examine the Stress1 graph.
Double-click the Stress1 
folder. View the results. 

Note: The maximum von Mises stress 
in the hole has decreased due to 
the addition of the ribs.

Close the graph.
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19 Review the Trend Journal.
Double-click the Trend Journal folder. The Trend 
Journal is displayed. The journal contains all details 
about the different iterations that were performed on 
the model.
Close the Trend Journal by closing Microsoft Word.

Using Trend Tracker, you can also roll back your model to 
an intermediate iteration without having to save any 
conceptual changes. Trend Tracker is also integrated with 
Design Scenarios in SolidWorks Simulation Professional 
to track structural feature changes.

20 Save and Close the Model.

Click Save .
Click File, Close from the Menu bar menu. 
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Thermal Analysis
Design performance can be compromised due to excessive temperatures or heat 
transfer between components. SolidWorks Simulation Professional allows you to 
perform thermal analyses with the following parameters:

Conduction, convection, and radiation
Steady state and transient with time-dependent loads
Temperature-dependent materials and loads
Temperature, heat flux, and heat power
Thermostats for closed-loop feedback in transient studies
Thermal contact resistance

You will again perform an analysis on the EndCap of the Housing. The Housing 
contains the camera and lighting system of the SeaBotix LBV150 assembly. The 
EndCap analysis will determine the amount of heat lost to the surrounding 
seawater. You will only address natural convection today. To simplify the model, 
the camera and lighting system are represented as a concentrated heat source.
Your design goal is to improve the thermal distribution of the EndCap. You will 
learn if the addition of Ribs, “mass,” will help to dissipate the generated heat from 
the camera and lighting system to the surrounding seawater.

Without Ribs With Ribs

Time: 10 - 15 minutes
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Create the Thermal Analysis Study
1 Open the EndCap Part.

Click Open  from the 
Menu bar toolbar. 
Double-click EndCap from 
the SeaBotix\SolidWorks 
Simulation 
Professional\Thermal folder.

Note: Files of type is Part. The EndCap 
is displayed in the Graphics area.

2 Create a Thermal Study.
Click the Simulation tab in 
the CommandManager.

Click the Study Advisor 
drop-down arrow from the Simulation tab.

Click New Study . The Study PropertyManager 
is displayed.
Enter Thermal-Study 1 for the name of the Study.

Click Thermal  for Type.
3 Display the Study.

Click OK  from the Study PropertyManager.
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Applying the EndCap Material.
1 Apply the Material of the EndCap.

Click EndCap from Thermal-Study 1 
(-Default-).

Click Apply Material  from the 
Simulation tab in the 
CommandManager. The Material 
dialog box is displayed. View your 
options. 
Click AISI 1020 from the Steel 
folder.
Click Apply.
Click Close from the Material dialog box. 

Note: A green check mark  on the Parts folder indicates that 
material is assigned to the part.
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Thermal Loads and Boundary Conditions
Thermal loads and restraints are only available for thermal studies. For steady 
state thermal studies with a heat source, a mechanism for heat dissipation must be 
defined. Otherwise, analysis stops because the temperatures increase without 
bound. Transient thermal studies run for a relatively short period of time and thus 
do not require a heat dissipation mechanism.
You will assume natural convection for the EndCap. You will apply a 600 watt 
power load to the system to simulate the heat load generated from the internal 
camera and search lights.
The following types of loads and restraints are available for thermal studies:
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Applying a Thermal Load
1 Apply a Thermal Load. 

Click the Thermal Loads drop-
down arrow from the Simulation 
tab in the CommandManager.

Click Heat Power . The Heat 
Power PropertyManager is 
displayed.

2 Select the Face.
Zoom in on the inside center hole face of 
the End Cap.
Click the inside center hole face of the 
EndCap as illustrated. Face<1> is 
displayed in the Selected Entities box. 
Note the icon system feedback symbol for 
a face.

3 Enter Heat Power.
Select SI from the Units drop-
down menu. 
Enter 600 watts in the Heat 
Power box.

Note: 600 watts is an estimate for the 
total amount of power generated 
by the camera and the internal 
search lights of the assembly.

4 Apply the Values.

Click OK  from the Heat 
Power PropertyManager. Heat 
Power-1 is displayed. 



SolidWorks Simulation SolidWorks Simulation Professional

Thermal Loads and Boundary Conditions 79

Applying Convection
1 Apply Convection.

Click the Thermal Loads 
drop-down arrow from the 
Simulation tab in the 
CommandManager.

Click Convection . The 
Convection 
PropertyManager is displayed.

2 Select the Exposed Faces.
Rotate the EndCap with the middle mouse button as 
illustrated.
Click the outside face of the EndCap. Face<1> is 
displayed in the Faces for Convection box.

3 Select the other three exposed outside 
Faces.

Click the other three outside faces of 
the EndCap. Face<2>, Face<3>, and 
Face<4> are displayed in the Faces for 
Convection box. Rotate the model to 
select Face<4>.

Note: Apply the Zoom to Area  tool from the 
Heads-up View toolbar to select the correct 
faces.
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4 Set Units and Value.
Select English (IPS) from the Units drop-down 
menu. 
Enter 0.22 in the Convection Coefficient box. 
Enter 50 in the Bulk Ambient Temperature box.

Note: The inputs simulate seawater conditions at the operating 
depth of 3,400 feet.

5 Apply the Values.

Click OK  from the 
Convection PropertyManager. 
Convection-1 is displayed. 

6 Fit the model to the Graphics area.
Press the f key.

Note: SolidWorks Simulation Professional 
applies convection to the four 
selected exposed faces and creates a 
single entry. Convection symbols 
appear on the four selected outside 
faces.
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Creating a Mesh and Run an Analysis
1 Create a Mesh and run an Analysis. 

Click the Run drop-down arrow 
from the Simulation tab in the 
CommandManager.
Click Create Mesh . The Mesh 
PropertyManager is displayed 
suggesting Global Size and 
Tolerance value. 
Check the Standard mesh box.
Check the Run (solve) the 
analysis box.

2 Start the Mesh Process.

Click OK  from the Mesh 
PropertyManager. You created a mesh 
and the Thermal1 plot is displayed. 
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3 View the Thermal Plot.
Double-click Thermal1 (-Temperature-). The 
Thermal Plot PropertyManager is displayed. View 
the options.
Click OK  from the Thermal Plot 
PropertyManager.
Right-click Thermal1 (-Temperature-).
Click Edit definition. The Thermal Plot 
PropertyManager is displayed.

4 Modify Temperature units.
Select Fahrenheit from the Temperature drop-
down menu.
Click OK  from the Thermal Plot 
PropertyManager. The Thermal Plot is displayed 
in Fahrenheit.
Rotate the model with the middle mouse button to 
view the temperature profile.

Note: Note that the 
maximum 
temperature is 
approximately 
673°F.
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Applying the Probe tool
1 Apply the Probe tool.

Click the Plot Tools drop-down 
arrow menu from the 
Simulation tab in the 
CommandManager.
Click Probe . The Probe 
PropertyManager is displayed. 
The Probe tool provides the 
ability to list the temperature at 
a specific location in the model. 
Zoom in on the inside face as 
illustrated.
Click five points as illustrated 
from top to bottom as 
illustrated. The Probe box lists 
the temperature and the X, Y, 
and Z coordinates of the 
selected vertices in the global 
coordinate system. 

Note: Results will vary depending on your selected position of 
the EndCap.

2 View and close the Probe Plot.

Click Plot . The Probe Result window appears 
with a graph of temperatures at the selected vertices 
versus node numbers at the vertices. View the plot.
Close the plot.
Click OK  in the Probe Result PropertyManager.

3 Fit the model to the Graphics window.
Press the f key.
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Modify the Design
In the first study, temperatures reaching 
approximately 673°F on the center hole of the 
EndCap were calculated using the supplied 
Load information. 
In this section, redesign the EndCap to use 
ribs. The ribs will help to dissipate the heat 
generated by the camera and search lights 
within the EndCap to the surrounding 
seawater. 

You will:
Unsuppress the rib feature in the EndCap 
part. 
Copy and paste the material and Load/
Restraint information from the first study 
to the second study. 
Mesh and Run the second analysis. 
View the results of the second study.
Compare the first study to the second 
study.

Without Ribs

With Ribs
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Create the Second Analysis
1 Create Thermal-Study 2.

Right-click the 
Thermal-Study 1 tab 
at the bottom of the 
Graphics area as 
illustrated.
Click Duplicate. The 
Define Study Name 
dialog box is 
displayed.
Enter Thermal-Study 
2 for new Study 
name.
Click OK from the 
Define Study Name dialog box. Thermal-
Study 2 is displayed. 

2 Add Ribs to the EndCap Part.
Click the Model tab at the bottom of the 
Graphics area.
Right-click CirPattern1 from the 
FeatureManager.
Click Unsuppress  from the Context 
toolbar. The EndCap with Ribs is displayed 
in the Graphics area.

3 Return to Thermal-Study 2.
Click the Thermal-Study 2 tab at the bottom 
of the Graphics area.
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4 Review Thermal-Study 2.
Review Thermal-Study 2. The Thermal 
information was copied from the first study to the 
second study. 

5 Analysis the Model.

Click Run  from the Simulation 
tab in the CommandManager. 
Thermal1 (-Temperature-) is 
displayed. View the plot in the 
Graphics area.

Note: The addition of the ribs resulted in a temperature range between 50 and 329 °F.
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6 Compare Study 2 to Study 1.

Click Compare Results  from the 
Simulation CommandManager. The 
Compare Results PropertyManager is 
displayed. Both Study 1 and Study 2 are 
checked.

Click the Compare selected results 
across studies box. Note: The Use settings from 
this plot for plots of the same type box is selected.
Click OK  from the Compare Results 
PropertyManager. View the results. The two 
Studies are displayed. 
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7 Return to Study 2.
Click the Exit Compare button. View Thermal-
Study 1.

8 Save and Close the Model.

Click Save .
Click Window, Close All from the Menu bar 
menu.

Note: You improved the thermal dissipation of the Endcap 
by adding the Ribs. The Ribs added mass, which in 
turned provided a better thermal load path to the 
entire part.
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Drop Test Analysis
A Drop Test study evaluates the effect of the 
impact of a part or an assembly with a rigid or 
flexible planar surface. Dropping an object on 
the floor is a typical application and hence the 
name. The program calculates impact and 
gravity loads automatically. No other loads or 
restraints are allowed. The program solves a 
dynamic problem as a function of time.
Will your Design Fail? 
The study does not answer this question 
automatically. It can predict the separation of 
components due to impact. You will use the 
results to assess the possibility of such an event 
occurring. You will use maximum stresses to 
predict material failure and contact forces to 
predict separation of components.
Perform a Drop Test analysis on the Housing 
component.

Time: 20 - 25 minutes
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Creating a Drop Test Study
1 Open the Housing Assembly.

Click Open  from the 
Menu bar toolbar. 
Double-click the 
Housing_Assy assembly 
from the 
SeaBotix\SolidWorks 
Simulation 
Professional\Drop_Test 
folder. The Housing is 
displayed in the Graphics 
area.

2 Create a Drop Test Study.
Click the Study Advisor 
drop-down arrow from the 
Simulation tab in the 
CommandManager.

Click New Study . The 
Study PropertyManager is 
displayed.
Enter Droptest Study 1 for 
Study Name.

Click the Drop Test  
button for Type.

3 Display the Study.

Click OK  from the Study 
PropertyManager. Droptest Study 
1 (-Default-) is displayed.
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4 Setup the Drop Test Study.
Right-click the Setup folder as illustrated. 
Click Define/Edit. The Drop Test Setup 
PropertyManager is displayed. 

Check the Drop height box.
Select ft for units from the drop-
down menu.
Enter 4 in the Drop height from 
centroid box.
Click inside the Gravity box.
Expand the Housing_Assy 
flyout FeatureManager from the 
Graphics area.
Expand the second CH EndCap 
component as illustrated
Click Plane3 from the flyout 
FeatureManager. Note: Under the 
second CH EndCap component. 
Plane 3 is displayed in the 
Gravity box.
Select m/sec2 for the Gravity 
magnitude units.
Click the Normal to gravity box.
Click the Rigid target box for 
Target Stiffness.

5 Display the Study.

Click OK  from the Drop Test Setup 
PropertyManager. Setup is displayed with a check 
mark.
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Meshing the Model 
1 Mesh the model.

Click the Run drop-down arrow menu from the 
Simulation tab in the CommandManager

Click Create Mesh . The Mesh 
PropertyManager is displayed.
Check the Standard mesh box as illustrated.
Expand the Advanced dialog box.
Check the Draft Quality Mesh box.

Note: A coarse Mesh Factor will result in a faster mesh 
time. Actual results will vary depending on Mesh 
Factor.

2 Start the Mesh and Analysis Process.

Click OK  from the Mesh PropertyManager. 
Meshing starts and the Mesh Progress window 
appears. After meshing is completed, a 
checkmark is displayed next to the Mesh folder.
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Running the Analysis
1 Run the Analysis.

Click Run . 
Click No in the Linear Analysis dialog 
box to retain your element choice. The 
analysis runs and the default plots are 
created.

Note: Run time will take approximately 15 - 30 
seconds.

2 Review the Results Folder.
Expand the Results folder. The 
Results folder contains three plots: 
Stress, Displacement, and Strain. 
View the Stress1 (-vonMises-) plot in 
the Graphics area.
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3 Set Scale Factor and View the von-Mises Plot.
Double-click Stress1 (-vonMises-). The Stress 
Plot PropertyManager is displayed. View the 
options.

Click OK  from the Stress Plot 
PropertyManager.
Right-click Stress1 (-vonMises-).
Click Edit Definition. The Stress Plot 
PropertyManager is displayed.
Click Automatic in the Deformed Shape box. 
Accept the default values.

Click OK  from the Stress Plot 
PropertyManager. View the plot in the Graphics 
area.
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Animating the Plot
1 Animate the Plot.

Click the Plot Tools drop-down arrow menu from 
the Simulation tab in the CommandManager.

Click Animate . The Animation 
PropertyManager is displayed.

If needed, click Play  to start the animation. 
View the animation in the Graphics area.

Click Stop  to stop the animation.

Click OK  from the Animation PropertyManager.
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Note: You can save the animation of the plot in an avi file format.

2 View the Displacement Plot. 
Double-click Displacement1 (-Res disp-). View the plot in the Graphics 
window.

3 Create the Time History Graph.
Right-click the Results folder.
Click Define Time History Plot. The 
Time History Graph PropertyManager is 
displayed.
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Click Node 1 as illustrated. 
Select Time for X-Axis from the drop-down menu.
Select Translational Acceleration for Y-axis from 
the drop-down menu.
Select g for Units from the drop-down menu.

4 View the Time History 
Graph.

Click OK  from the 
Time History Graph 
PropertyManager. 
View the Graph.
Close the Time History 
Graph. 

5 Save and Close the 
Model.

Click Save .
Click Window, Close 
All from the Menu bar 
menu. 



SolidWorks Simulation Professional SolidWorks Simulation

98 Notes:

Notes:
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Optimization Analysis
The Optimization analysis enables designers to meet functional design 
specifications without wasting materials and overdesigning. Seemingly 
insignificant amounts of weight cut from dozens of components can add 
significant cost reductions in production, shipping, and packaging. You can also 
test designs with alternate lighter or lower-cost materials in SolidWorks 
Simulation.
Perform an Optimization analysis today on the EndCap. The goal of the analysis 
is to minimize the mass of the EndCap. Optimize the EndCap Lip thickness and 
the Rib thickness in the analysis.

 Rib Thickness

Lip
Thickness

The Factor of Safety is greater than one.

Time: 15 - 20 minutes
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Creating an Optimization Analysis
1 Open the Part.

Click Open  from the 
Menu bar toolbar. 
Double-click EndCap from 
the SeaBotix\SolidWorks 
Simulation 
Professional\Optimization 
folder. The EndCap (Add 
Rib) configuration is 
displayed in the Graphics 
area. 

2 View Static Study1.
A Static study was created for 
this part. Click the Study 1 
tab located at the bottom of 
the Graphics area as 
illustrated. Study 1 is 
displayed.

3 Run Study 1.

Click Run  from the Simulation 
tab in the CommandManager. View 
the created plots in the Results folder. 
The Stress1 (-vonMises-) plot is 
displayed in the Graphics area.
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4 Create an Optimization Study.
Right-click on the Study 1 tab at the bottom 
of the Graphics area.
Click Create New Design Study. The 
Design Study 1 tab is displayed along with 
the Design Study dialog box.
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Note: You can also click Simulation, 
Design Study from the Menu 
bar menu.

5 Select the First Design 
Variable (EndCap Thickness) 
for the Optimization Study.

Click Add Parameters 
from the Variables drop-
down menu. The Parameters 
dialog box is displayed.

6 Enter the Name.
Click inside the 
Name box.
Enter EndCap 
Thickness for 
name. 

7 Enter EndCap Lip 
thickness.

Click the drop-
down arrow from 
the Model 
Dimension 
Category.
Select Model 
Dimension from 
the Category 
column.
Click inside the 
Value column box.
Rotate the model 
with the middle 
mouse button and 
zoom in on the 
.150in EndCap Lip 
thickness 
dimension.
Click the .150 
EndCap Lip thickness dimension as illustrated. The selected dimension is 
displayed in the Value column. Units are displayed in the Units box.
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Click Apply. The 
information is 
added to the 
Parameters dialog 
box.

8 Select the Second 
Design Variable.

9 Enter the Name.
Click inside the 
Name box.
Enter Rib 
Thickness for 
name.

10 Enter Rib Thickness.
Click the drop-
down arrow from 
the Model 
Dimension 
Category.
Select Model 
Dimension from 
the Category 
column.
Click inside the 
Value column box.
Click the .150 
EndCap Rip 
thickness 
dimension as 
illustrated. 
Click Apply.
Click OK.
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11 Expand the Variables cell in the Design Study.
Click the drop-down arrow in the Variables cell. View the results.

12 Set the ranges for the variables in the Design 
Study.

Select Range from the drop-down menu for 
EndCapThickness.
Select Range from the drop-down menu for 
RibThickness.
Enter the illustrated numbers for the 
EndCapThickness (Min: & Max:) range and 
the RibThickness (Min: & Max:) range.

13 Set a Constraint (Sensor to monitor) the study.
Click Add Sensor from the Constraint drop-
down menu. The Sensor PropertyManager is 
displayed.
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Select Simulation Data for Sensor Type.
Select Stress for Results.
Select psi for Units.
Click OK  from the Sensor PropertyManager.

14 Set the conditions 
for the Constraint.

Select Is less 
than for Stress.
Enter 60000 for 
Max condition.

15 Set a Goal (Sensor to monitor) the study.
Click Add Sensor from the Goals drop-down 
menu. The Sensor PropertyManager is 
displayed. Accept the default Sensor Type: 
Mass Properties. 
Click OK  from the Sensor 
PropertyManager.
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16 Set the condition for the Goal.
Select Minimize.

17 Run the Design Study.
Click the Run button. The 
results table is displayed and 
updated as the study is running. 
This may take a few minutes. 
View the finished table. You 
can now interact with the 
results.
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18 Interact with the Results.
Click in the Initial 
Column.
Click in the Optimal 
Column. Compare the 
two columns.

Note: You can look at any of the 
individual designs by 
dragging the EndCap 
Thickness or Rib 
Thickness slider.

19 View the Trend Results.
Right-click the Results and Graphs 
folder.
Click Define Local Trend Graph. The 
Local Trend PropertyManager is 
displayed. View your options.
Click Constraint. Accept the default 
settings.
Click OK  from the 
PropertyManager. View the results in 
the Graphics area.
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20 Close the Graph1 dialog box.
Click Close.

21 Save and Close the Model.

Click Save .
Click Window, Close All 
from the Menu bar menu.
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Fatigue Analysis
It is observed that repeated loading 
and unloading weakens objects over 
time even when the induced stresses 
are considerably lower than the 
allowable stress limits. This 
phenomenon is known as fatigue. 
Each cycle of stress fluctuation 
weakens the object to some extent. 
After a number of cycles, the object 
becomes so weak that it fails. 
Fatigue is a primary cause of the 
failure in many objects, especially 
those made of metals.
The SeaBotix LBV150 contains an optional MiniGrab assembly. In this study, you 
will analyze the 3 Finger Jaw part which is attached to the SeaBotix LBV150 to 
grip and hold objects from the sea floor. Before you create the Fatigue analysis, 
perform a Static analysis with a force applied to the tips of the 3 Finger Jaw.

3 Finger Jaw

 MiniGrab Assembly

Time: 15 - 20 minutes
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Creating a Fatigue Analysis
1 Open the Part.

Click Open  from the Menu bar 
toolbar. 
Double-click 3 Finger Jaw from 
the SeaBotix\SolidWorks 
Simulation Professional\Fatigue 
folder.

2 Create a Static Analysis Study.
Click the Study Advisor drop-down arrow from the 
Simulation tab in the CommandManager. 

Click New Study . The Study PropertyManager is 
displayed.
Enter Static-Study 1 for 
name. 

Click Static  for Type.

3 Display Static-Study 1.

Click OK  from the Study 
PropertyManager. 

Note: The Static-Study 1 tab is 
displayed in the bottom corner of 
the Graphics area.
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Applying Material
1 Apply Material.

Click Apply Material  from the 
Simulation tab in the 
CommandManager. The Material 
dialog box is displayed.
Expand the Aluminum Alloys folder.
Click 6061-T6(SS) Alloy. View the material properties. 
Click Apply.
Click Close. Material is applied to the part.

Note: A green check mark  on the Parts folder indicates that material is assigned to 
the parts. 
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Adding a Fixture
1 Add a Fixture.

Click the Fixtures Advisor drop-down arrow 
from the Simulation tab in the CommandManager
Click Fixed Hinge. The Fixture PropertyManager 
is displayed.

2 Select the Cylindrical Face to be 
Fixed.

Click the inside cylindrical face 
of the hole in the 3 Finger Jaw as 
illustrated. Face<1> is displayed. 
Note the icon feedback symbol 
for a face.

Click OK  from the Fixture 
PropertyManager. Fixed Hinge-1 
is displayed.
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3 Add a Second Fixture.
Click the Fixtures Advisor drop-down arrow from 
the Simulation tab in the CommandManager.
Click Advance Fixtures. The Fixture 
PropertyManager is displayed. Perform a radial 
support on the right-hand face.

4 Select the inside Cylindrical 
Face.

Click the On Cylindrical 

Faces  box.
Rotate the model to view the 
side cylindrical face as 
illustrated.
Click the inside face of the 
slot as illustrated. Face<1> is 
displayed. 

5 Select Units and Displacement 
Components.

Select inch from the Units 
drop-down menu.

Click the Radial  box.
6 Apply the Second Fixture.

Click OK  from the Fixture 
PropertyManager. On 
Cylindrical Faces-1 is 
displayed.
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Applying a Force
1 Apply a Force.

Click the External Loads drop-down arrow from the 
Simulation tab in the CommandManager.

Click Force . The Force/Torque 
PropertyManager is displayed.
Check the Normal box.

2 Select the contact face.
Rotate the model with 
the middle mouse 
button to view the top 
contact face as 
illustrated.
Click the top contact 
face. Face<1> is 
displayed in the Faces 
for Normal Force box.

3 Set Units and Value.
Select English (IPS) in the 
Units box. 
Enter 30lbf in the Force value 
box.

Note: 30lbf is the normal force that the 
MiniGrab assembly can apply in 
holding an object from the sea 
floor.

4 Apply the Force.

Click OK  from the Force/
Torque PropertyManager. 
Force-1 is displayed.
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Meshing and Running the Model
1 Mesh and Run the Model.

Click the Run drop-down arrow 
from the Simulation tab in the 
CommandManager

Click Create Mesh . The 
Mesh PropertyManager is 
displayed. 
Click Standard mesh.
Check the Run (solve) the 
analysis box.

Click OK  from the Mesh 
PropertyManager. View the 
results. Three plots are created.

2 Fit the model to the Graphics area.
Press the f key. View the Stress1 
(-vonMises-) plot in the 
Graphics area. 
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Performing a Fatigue Check Plot.
1 Create a New Fatigue Study.

Right-click the Results folder.
Click Define Fatigue Check Plot. The Fatigue 
Check Plot PropertyManager is displayed.

2 View the Fatigue Check Plot.
Click the Fully Reversing Load button. View 
the results in the Graphics area. There is a 
possible Fatigue issue.

Click Cancel  from the Fatigue Check Plot 
PropertyManager. 
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Creating a New Fatigue Study.
1 Create a New Fatigue Study.

Click the Study Advisor drop-
down arrow from the 
Simulation tab in the 
CommandManager. 

Click New Study . The 
Study PropertyManager is 
displayed. 
Enter Fatigue-Study 1 for 
Name.

Check Fatigue  for Type.
2 Display the Study.

Click OK  from the Study 
PropertyManager. View 
Fatigue-Study 1 (-Default-).

Note: The Fatigue-Study 1 tab is 
displayed in the bottom corner of 
the Graphics area.

3 View Loading Event.
Click the Fatigue drop-down 
arrow from the Simulation tab 
in the CommandManager. 

Click Add Event . The Add 
Event (Constant) 
PropertyManager is displayed.
Select Static-Study 1 from the 
drop-down menu.
Enter 100000 cycles box. 

Click OK  from the Add 
Event (Constant) 
PropertyManager. 
Click 3Finger Jaw in the Study 
tree. 



SolidWorks Simulation Professional SolidWorks Simulation

118 Fatigue Analysis

4 Edit the Fatigue data.
Right-click 3 Finger Jaw.
Click Apply/Edit Fatigue Data. The Material 
dialog box is displayed.
Check the Derive from material Elastic 
Modulus box.
Select Log-log from the Source area. 
Click Apply.
Click Close. View the results.

5 Run the Study.

Click Run  from the Simulation 
CommandManager. View the Results 
folder.

Note: 100,000 cycles represents approximately 
100 cycles/dive x 100 dives/year x 10-year 
life expectancy of the unit.
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6 View the Life Plot.
Double click on the Results2 (-
Life-) folder. The Life plot is 
displayed.

7 Display the Chart Options 
PropertyManager.

Double-click on the Total Life 
(cycle) plot in the Graphics 
areas as illustrated. The Chart 
Options PropertyManager is 
displayed.

8 Reverse the Life plot results color.
Expand the Color Options box.
Click the Flip box.

Click OK  from the Chart Options 
PropertyManager. View the results in the 
Graphics area.
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Applying a Load Factor
1 Apply a Load Factor.

Right-click the Results folder.
Click Define Fatigue Plot. The Fatigue Plot 
PropertyManager is displayed.
Check the Load Factor box.

Click OK  from the Fatigue Plot 
PropertyManager. View the Results folder. 

2 Save and Close the Model.
Click Window, Close All from the Menu bar 
menu. You are finished with the SolidWorks 
Simulation Professional section of the HOTD 
manual.
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SolidWorks Simulation Professional Conclusion
In your short time today, you have seen firsthand the functionality of SolidWorks 
Simulation Professional applications. In addition to the design validation 
functionality contained in SolidWorks Simulation, SolidWorks Simulation 
Professional offers expanded analysis capabilities including: Thermal, Frequency, 
Buckling, Optimization, Fatigue, and Drop Test Simulation.
Understand the effects of temperature changes. Temperature variations 
encountered by mechanical parts and structures can greatly influence the 
performance of your designs.
Evaluate natural frequencies or critical buckling loads and their 
corresponding mode shapes. Often overlooked, inherent vibration modes in 
structural components or mechanical support systems can shorten the life of your 
product and cause unexpected failures.
Optimize designs based on your defined criteria. Design optimization 
automatically determines the optimal design based on your specified criteria.
Simulate virtual drop tests on a variety of surfaces. In the event that your part 
or assembly might be dropped, find out whether or not it can survive the fall 
intact.
Study the effects of cyclic loading and fatigue operation conditions. See the 
effects of fatigue on the overall lifecycle of your part or assembly to find out how 
long it will last and what design changes can extend its working life.
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SolidWorks Flow Simulation

When you complete this chapter, you will have experienced the power and 
capabilities of SolidWorks Flow Simulation, including:

The benefits of using fluid-flow analysis.
The ease of use of SolidWorks Flow Simulation to perform analysis on your 
design.
The steps for performing upfront analysis on your designs.
The integration between SolidWorks Flow Simulation and SolidWorks.
The results of cost reduction with virtual prototypes to save resources.
The ability to document your analysis findings automatically.

Time: 20 - 25 minutes
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SolidWorks Flow Simulation 
SolidWorks Flow Simulation is the 
first easy-to-use fluid-flow 
simulation and thermal analysis 
program that is fully embedded 
inside SolidWorks. You will utilize 
SolidWorks Flow Simulation to 
understand, validate, and improve 
new product ideas during the 
design phase.

SolidWorks Flow Simulation 
provides the user insight into parts 
or assemblies related to fluid flow, 
heat transfer, and forces on 
immersed or surrounding solids. 

You will use the SolidWorks Flow 
Simulation Wizard to analyze the 
drag created by the SeaBotix 
LBV150 assembly as it moves 
through seawater. This information 
is critical to choose the correct size 
thruster required for the assembly 
to perform its tasks.
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Starting a SolidWorks Flow 
Simulation Session

1 Open the SeaBotix 
LBV150 Assembly.

Click Open  from 
the Menu bar toolbar. 
Double-click 
LBV_ASSY from the 
SeaBotix\SolidWorks 
Flow Simulation 
folder. A simplified 
model opens in the 
Graphics area.

2 Activate SolidWorks Flow 
Simulation module.

Click the Options  drop-down 
arrow from the Menu bar toolbar as 
illustrated. 
Click Add-Ins. The Add-Ins dialog 
box is displayed.
Check the SolidWorks Flow 
Simulation 2013 box. 
Click OK from the Add-Ins dialog 
box. The Flow Simulation tab is 
displayed in the 
CommandManager.
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3 Start the SolidWorks Flow 
Simulation Wizard.

Click the Flow 
Simulation tab located 
in the 
CommandManager.

Click the Wizard  
tool. The Wizard - 
Project Configuration 
box is displayed. 
Create new is selected 
by default. Accept the 
default settings.
Click Next>. The 
Wizard Unit System 
dialog box is 
displayed.

Click IPS (in-lb-s) for 
Unit system.
Click inside the 
Velocity Unit box.
Click Knot from the 
drop-down menu as 
illustrated.
Click .123 from the 
drop-down menu from 
the Decimals in results 
display column.
Click Next>. The 
Wizard - Analysis Type 
dialog box is displayed.
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Click the External box 
for Analysis type. 
Click Next>. The 
Wizard - Default Fluid 
dialog box is displayed.

Expand the Liquids 
folder.
Click Water.
Click the Add button. 
Water is displayed in the 
Project Fluids box.
Click Next>. The 
Wizard - Wall 
Conditions dialog box is 
displayed. Accept the 
default settings.
Click Next>. The 
Wizard - Initial and 
Ambient Conditions 
dialog box is displayed.
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Double-click inside the 
Value box of Velocity in 
X direction as illustrated.
Enter 2 kn for Velocity.
Click Next>. The Wizard 
- Results and Geometry 
Resolution dialog box is 
displayed.

Note: Two knots is the operating 
speed.

4 Complete the SolidWorks 
Flow Simulation Wizard.

Accept all default 
settings. Click the Finish 
button.
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5 View the Simulation.
Press the z key three or four 
times to Zoom out to view the 
model. The surrounding box 
simulates the seawater around 
the assembly. 

6 Analyze the Drag.
Click the Flow Simulation 

analysis tree  tab. 
Expand the Input Data folder.
Right-click Goals.
Click Insert Global Goals. 
The Global Goals 
PropertyManager is displayed.
Scroll down and check the Max 
box in Force(X).

Click OK  from the Global 
Goals PropertyManager.
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7 Run the Analysis.

Right-click Run  
from Project 1 as 
illustrated. The Run 
dialog box is displayed.
Select 1 CPU from the 
drop-down menu,
Click the Run button.

Note: To save classroom time, we 
will stop the analysis and 
open the Results folder to 
review completed results.

8 Stop the Analysis.
Wait until the third 
iteration and click Stop 
from the Solver box as 
illustrated.
Click No to the question, 
“Do you want to save 
the results?”
Click File, Close from 
the Solver Main menu.

9 Open the Configuration 
with the Solved Results.

Click the ConfigurationManager  tab.
Double-click the Default (3) configuration as 
illustrated.

Click the Flow Simulation analysis tree  
tab.
Right-click the Results folder.
Click Load Results. The Load Results dialog 
box is displayed.
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Double-click 3.fld in folder 3.

10 Create a Section Plot.
Expand the Results folder.
Right-click the Cut Plots folder. 
Click Insert. The Cut Plots 
PropertyManager is displayed. 
Front Plane is selected by default. 

Expand LBV_ASSY from the fly-
out FeatureManager. View the 
features. Front Plane is displayed 
in the Section Plane box.

Click the Contours  button in 
the Display box.
Click the drop-down menu in the 
Contours box to select Velocity as 
illustrated.
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Click the Adjust 
Minimum and Maximum 
button. View the range.

11 View the Section Plot.

Click OK  from the Cut 
Plot PropertyManager. View 
the Section plot in the 
Graphics area.

Note: Click Flow Simulation, 
Units from the Main menu 
bar to modify decimal places 
in results display.

12 Move the Section Plot in 
the Graphics area.

Expand the Cut Plots 
folder.
Click Cut Plot1. View the 
control arrow in the 
Graphics area.
Click and drag the control 
arrow to the left side of the 
computational domain. 
View the changing results 
of the Section plot.
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Click and drag the control 
arrow to the right side of 
the computational domain.
Move the Section Plot 
back to its original location 
in the computational 
domain.
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13 View the moving Computational 
Domain.

Right-click Cut Plot1.
Click Play. View the results in 
the Graphics area.

14 Stop the moving Computational 
Domain.

Right-click Cut Plot1.
Click Stop. View the results in 
the Graphics area.

15 Hide the Computational Domain.
Right-click the Computational 
Domain folder.
Click Hide. 

16 Create a Second Cut Plot.
Right-click the Cut Plots folder.
Click Insert. Front Plane is 
selected by default. 
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17 Change the Selected Plane.
Expand LBV_Assy from the fly-
out FeatureManager. 
Click Top Plane from the fly-out 
FeatureManager. Top is 
displayed in the Selection plane 
or face box. 

18 Continue the Second Cut Plot.

Click the Contours  button.
Select Pressure from the drop-
down menu for Parameter.
Click the Adjust Minimum and 
Maximum button. View the 
range.

Click OK  from the Cut Plot 
PropertyManager. View the 
Section plots in the Graphics 
area.
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19 Hide the first Section Plot.
Right-click Cut Plot1.
Click Hide. View the results.

Note: Click the FeatureManager tree tab as 
illustrated to view the full Graphics area.
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20 Hide the Section Plots.
Right-click the Cut Plots folder.
Click Hide All. View the model in the 
Graphics area.
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Applying Flow Trajectories 
Flow trajectories are displayed as flow 
streamlines. Flow streamlines are curves 
where the flow velocity vector is tangent 
to that curve at any point on the curve. 
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Applying Flow Trajectories
1 Create a Flow Trajectory.

Right-click the Flow Trajectories folder. 
Click Insert. The Flow Trajectories 
PropertyManager is displayed.
Expand LBV_Assy the fly-out 
FeatureManager.
Click Right Plane. Right is displayed in 
the Reference box.
Slide the Offset slider as illustrated to 
approximately -21.

Click OK  from the Flow Trajectories 
PropertyManager. Flow Trajectories 1 is 
displayed.
Zoom-out and rotate the model to view 
the plot.
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2 Edit the Flow Trajectory.
Expand the Flow Trajectories 
folder.
Right-click Flow Trajectories 1.
Click Edit Definition. The Flow 
Trajectories PropertyManager is 
displayed.

Pin  the Flow Trajectories 
PropertyManager.
Enter 100 for the Number of Points 
as illustrated.
Click Lines with Arrows from the 
drop-down menu in the Appearance 
box.

Un-Pin  the Flow Trajectories 
PropertyManager.

Click OK  from the Flow 
Trajectories PropertyManager. 
View the plot. If needed, click the 
FeatureManager tree tab to hide or 
click and drag the Pressure bar. 
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3 Animate the Flow Trajectory study.
Right-click the Flow Trajectory 1 folder.
Click Animate. The Animation 1 tab is 
displayed at the bottom of the Graphics area.

Click Play . View the 
animation of the model.

Click OK  from the 
Animation toolbar to 
return to the 
FeatureManager.
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4 Hide the Flow Trajectory.
Right-click the Flow Trajectories 1 folder.
Click Hide. View the Graphics area.

5 Set the Goal Plots.
Expand the Results folder.
Right-click the Goal Plots folder as 
illustrated.
Click Insert. The Goal Plot 
PropertyManager is displayed.
Check the GGX-Component of Force1 
box as illustrated.

Click OK  from the Goal Plot 
PropertyManager. The Goals dialog box 
is displayed. View your options.



SolidWorks Flow Simulation SolidWorks Simulation

144 Applying Flow Trajectories

6 View the Excel Plot.
Click the bottom Force (X) tab. 
View the plot.

7 Close the Excel Plot and return to 
SolidWorks Flow Simulation.

Click Close.
Select Don’t Save when prompted to 
Save.

8 Save and Close the model.
Click File, Close from the SolidWorks 
Main menu.
Click Save All when prompted to save. 
You are finished with the SolidWorks 
Flow Simulation section of the HOTD 
manual.
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SolidWorks Flow Simulation 
During this short session on using SolidWorks 
Flow Simulation, you have had a brief 
exposure to the main concepts of fluid-flow 
simulation. SolidWorks Flow Simulation 
gives you insight into parts and assemblies 
related to fluid flow, heat transfer, and forces 
on immersed or surrounded solids.
The only fluid-flow simulation product fully 
integrated with SolidWorks, SolidWorks Flow 
Simulation is incredibly easy to use; you 
simply tell the software what you’re interested 
in instead of having to translate analysis 
design goals into numerical criteria and 
iteration numbers.
Access physical fluid models for 
engineering applications. SolidWorks Flow 
Simulation can analyze a wide range of real 
fluids such as air, water, juice, ice cream, honey, plastic melts, toothpaste, and 
blood, which makes it ideal for engineers in nearly every industry.
Simulate real-world operating conditions. SolidWorks Flow Simulation 
includes several types of boundary conditions to represent real-life situations.
Automate fluid-flow tasks. SolidWorks Flow Simulation utilizes a number of 
automation tools to simplify the analysis process and help you to work more 
efficiently.
Interpret results with powerful and intuitive visualization tools. Once you 
have completed your analysis, SolidWorks Flow Simulation offers a variety of 
results visualization tools that allow you to gain valuable insight into the 
performance of your model.
Collaborate and share analysis results. SolidWorks Flow Simulation makes it 
easy to collaborate and share analysis results effectively with everyone involved 
in the product development process.
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SolidWorks Motion

When you complete this chapter, you will have experienced the power and 
capabilities of SolidWorks® Motion, including:

The benefits of using motion analysis.
The ease of use of SolidWorks® Motion to perform analysis on your design.
The steps for performing a motion simulation on your designs.
The integration between SolidWorks Motion and SolidWorks.
An understanding of the performance aspects and time savings before 
physical prototyping.

Time: 20 - 25 minutes
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SolidWorks Motion
SolidWorks® Motion is designed for mechanical system simulation and ensures 
that a mechanism works before it is built.
SolidWorks Motion will:

Provide confidence that your assembly performs as expected without parts 
colliding while they move.
Increase the efficiency of your mechanical design process by providing 
mechanical system simulation capability within the familiar SolidWorks 
environment.
Use a single model, without transferring geometry and other data from 
application to application.
Eliminate the expense caused by design changes late in the manufacturing 
process.
Speed the design process by reducing costly design change iterations.

Today, perform an analysis on the Gripper assembly.
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Starting a SolidWorks Motion 
Session

1 Open the Gripper 
Assembly.

Click Open  from 
the Menu bar menu. 
Double-click the 
Gripper Motion 2013 
assembly from the 
SeaBotix\SolidWorks 
Motion folder.

Ac

2 Activate SolidWorks 
Motion.

Click the Options  drop-down 
arrow from the Menu bar toolbar.
Click Add-Ins. The Add-Ins dialog 
box is displayed. 
Check the SolidWorks Motion box. 
Click OK from the Add-Ins dialog 
box.
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3 Start a SolidWorks Motion Study.
Click the Motion Study 1 tab at the bottom of the Graphics area as illustrated.
Click the drop-down arrow from the Motion Study Manager.
Select Motion Analysis. View the available selections from the Motion Study 
Manager.
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Applying Motion to a Component
A linear motor (actuator) is a device which imparts a 
translational motion to a component. A linear motor in 
SolidWorks Motion moves the selected component at a 
constant speed or variable speed.
Apply a linear motor to the Push-Pull Plate component 
in the Gripper assembly. The linear motor will move 
the Push-Pull Plate component a specified distance in a 
specified time. This action will cause the fingers of the 
Gripper assembly to close.
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Applying Linear Motion
4 Apply Linear Motor.

Zoom in on the Push-Pull 
Plate component.
Click the Push-Pull Plate 
component face of the Gripper 
assembly as illustrated. 

Note: View the icon symbol and 
information feedback.

Click the Motor  icon from 
the Motion Manager toolbar. 
The Motor PropertyManager 
is displayed.
Click the Linear Motor 
(Actuator) box for Motor 
Type.
Click the Reverse Direction 
button. 
Click the Push-Pull Plate 
component face of the Gripper 
assembly. The direction arrow 
points inward.
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5 Display the Function Builder.
Select Segments for Motion Type from the 
drop-down menu. The Function Builder 
dialog box is displayed. Use the Function 
Builder to define motor or force profiles from 
an imported data set. You can also use the 
Function Builder to define a motor or force 
profile from a mathematical expression or 
from interpolated functions along connected 
segments. For motor profiles, you can specify 
time, cycle angle, or any result as the 
independent variable.

6 Add Rows.
Click Click to add row. A new row is 
displayed.
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Fill in the following 
numbers and rows as 
illustrated. View the results.

Click OK from the Function Builder dialog box.

Click OK  from the Motor PropertyManager. LinearMotor1 is displayed in 
the Motion Study FeatureManager.
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7 Edit Key Point Time for Motion Study.

Right-click the Key Properties  icon as illustrated.
Click Edit Key Point Time.
Enter .2 for time.

Click Save  from the Edit Time dialog box.

Click the Zoom to Fit  icon in the Motion Study. View the results.
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Applying Forces
Forces define loads and compliances on parts. Forces may resist motion, such as 
springs or dampers, or they may induce motion.
The 3 Finger Jaw components experience an applied force. To simulate the 
loading conditions, you will perform the following tasks:

Select the middle contact surface from one of the 3 fingers. 
Insert an applied action-only force of 62 N to the selected finger. 
Repeat the process on the other two fingers.
Create and run a simulation.
Compute the reaction force at the finger hinge.
Create a trace path for the tip of one finger.
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Applying Force to the Gripper 
Fingers

1 Select a Contact Face.
Rotate the Gripper assembly 
with the middle mouse button 
to view the inside faces of a 
finger as illustrated. 
Zoom in to selected the first 
contact face.

Note: Select any of the 3 Gripper 
fingers.

Click the contact 
finger face as 
illustrated.

2 Apply the Force.

Click the Force  
icon from the Motion 
Manager toolbar. The 
Force/Torque 
PropertyManager is 
displayed.
Click the Force box 
for Force Type.
Click the Action only 
box for Direction.
Click the Reverse 
Direction button. The 
direction arrow points 
into the finger.
Enter 62 N for Constant Value.

Click OK  from the Force/Torque 
PropertyManager. Force1 is displayed in the 
Motion Study FeatureManager.
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3 Apply a Contact Force to the two other Fingers.
Repeat Step 1 & 2 for the other two Gripper fingers. At the end of this step, 
you should view three Forces and a LinearMotor in the Motion Study 
FeatureManager as illustrated.

4 Run the Motion Simulation.

Click the Calculate  icon. 
If needed click Yes to the message 
in the dialog box. View the 
assembly moving while the analysis 
is being performed.

5 Calculate the Reaction Force at the 
Finger Hinge.

Click the Results and Plots  icon from 
the Motion Study toolbar. The Results 
PropertyManager is displayed.
Select Forces from the Result drop-down 
menu.
Select Reaction Force from the Result 
drop-down menu as a sub-category.
Select Magnitude from the Result drop-
down menu as the Result component.
Expand the Mates folder from the Motion 
Study FeatureManager.
Click Concentric 2 from the Mates folder.

Click OK  in the Results 
PropertyManager. 
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Click No to the displayed message. View the plot. 
Click along the time axis and view the changes in the Gripper. 

Note: Do not close Plot1 at this time.
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6 Edit the LinearMotor1 Feature.
Right-click LinearMotor1 in the Motion 
Study FeatureManager.
Click Edit Feature. The Motor 
PropertyManager is display.
Click the Edit button. The Function 
Builder dialog box is displayed.
Modify the EndX (.05) time cell as 
illustrated. Note the update in the plots.
Click OK from the Function Builder 
dialog box.

7 Return to the SolidWorks Motion 
Graphics area.

Click OK  in the Motor 
PropertyManager.
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8 Re-run the Motion Simulation.

Click the Calculate  icon. View the 
results of the new plot in the Graphics 
area.
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9 Create a Trace Path.

Click on the Results and Plots  icon 
from the Motion toolbar. The Result 
PropertyManager is displayed.
Select Displacement/Velocity/
Acceleration from the drop-down menu 
in the Result box.
Select Trace Path from the drop-down 
menu as a sub-category.
Click a point at the end of a finger as 
illustrated in the Graphics area. Note the 
icon feedback symbol.

Click OK  from the Results 
PropertyManager. 

Note: A Trace Path graphically displays the path 
that any point on any moving part follows.
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10 Zoom in to view the results.
Use the middle mouse wheel to zoom in on the Trace Path.

11 Re-run the Motion Simulation.
Click Play from Start. View the results 
in the Graphics area.
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12 Disable Playback of view Keys.
Right-click Orientation and 
Camera Views from the Motion 
Study FeatureManager.
Click Disable Playback of View 
Keys.
Click Play from Start. View the 
results in the Graphics area.

13 Rebuild and Save the Assembly.

Click Save  from the Menu 
bar toolbar.
Click OK to the Rebuild message.

14 Close all models.
Click Window, Close All from 
the Menu bar menu. You are 
finished with the SolidWorks 
Motion section of the HOTD 
manual.
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SolidWorks Motion Conclusion
During this short session on SolidWorks Motion, you have seen how physics-
based motion simulation can be used to improve the quality and performance of 
your design. SolidWorks Motion simulates the mechanical operations of 
motorized assemblies and the physical forces they generate, by determining 
factors such as power consumption and interference between moving parts. 
SolidWorks Motion helps you ascertain if your designs will fail, when parts will 
break, and whether or not they will cause safety hazards.

Leverage the power of SolidWorks. SolidWorks Motion works inside the 
SolidWorks window and uses existing assembly information to build motion 
simulation studies.

Transfer loads seamlessly into SolidWorks Simulation to perform stress 
analysis.
With the seamless transfer of loads from SolidWorks Motion to SolidWorks 
Simulation, you can visualize stress and displacements on a component as a single 
time instance or for the entire simulation cycle.
Simulate real-world operating conditions. By combining physics-based motion 
with assembly information from SolidWorks, SolidWorks Motion can be used in a 
broad span of industry applications.

Associate physics-based models to engineering conditions. SolidWorks 
Motion offers several types of joint and force options to represent real-life 
operating conditions.

Interpret results with powerful and intuitive visualization tools. Once you 
have completed the motion simulation run, SolidWorks Motion offers a variety of 
results visualization tools that allow you to gain valuable insight into the 
performance of your design.

Collaborate and share analysis results. SolidWorks Motion makes it easy to 
collaborate and share analysis results effectively with everyone involved in the 
product development process.
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